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Issues Addressed in V8.1.8 compared to V8.1.5 

Performance improvements to improve memory management in recording server, addressing issues where server with high number of 

cameras could overload when multiple clients requested image streams 

Addressed issue where realtime audio was not heard, playback audio was ok 

Addressed issue where playback position could jump unexpectedly during playback if VCA was in use. 

Addressed issue where database connection could be lost if the SQL server went offline and returned later. 

Addressed issue where one IO button press icon state was wrong 

Addressed issue noticed in 8.1.4 upgrade where camera went randomly to "not configured" state after VMS software upgrade 

Addressed issue where exporting a video clip from other video clip failed if the clip was originally exported from older version of VMS. 

Addressed issue where stream was closed when camera was configured not to record anything, client had realtime stream open and the 

motion detection tab in system manager was used. 

Several improvements to increase performance when opening a large amount of cameras, for example, in a scenario where several 

EasyView windows are opened with multiple tabs with lots of cameras. 

Added setting for enabling increased communication security - use of this setting can affect system performance. Default setting is off, 

improving system performance compared to earlier V8.x releases. 

Addressed issue where assigning email addresses to email groups with the arrow buttons was not working properly. 

Addressed issue with dynamic camera settings UI with Axis cameras: control mode passive was not working. 

Addressed issue where using window/monitor numbers, the originating window size was sent to the receiving window, resulting in 

window size change when controlling the window contents. 

Addressed issue where joystick settings import was not working. 

Addressed issue where a VMS server with a large amount of analog cameras could hang when opening too many streams 

simultaneously with the activity data calculation in clients activated. 

Addressed issue where playback of material did not work OK in case of VCA metadata on the channel. The playback position could jump 

unexpectedly to the live/real-time position even there was material not yet played. 

 
 

New Features in V8.1.5 compared to V8.0.1 

There is a new, shorter timers available for PTZ tour programs (1,2,3 and 4 seconds) 

Diagnostic tool to observe VMS server loaf: If the system is overloaded, it will skip frames either in image processing or in network send. 

The tool allows to monitor the behavior of the server and re-adjust camera settings to be lower in case of an overloaded situation: 

 



 
Option to Improve data encryption between system components - all client-to-server and server-to-server communications compressed 

and encrypted with connection-specific keys (256 bit AES) on top of existing sensitive data encryption (256 bit AES). 

EasyView Help and User Guide updated for English and Finnish languages. 

System Manager Help and Administration Guide updated for English and Finnish languages. 

It is possible to enable login window site selection from System Manager General settings. 
 

Keyboard shortcuts for controlling the view components modes.The shortcut will cycle between the different view modes: hidden, normal, 

large and autohide (when availalble)). The shortcut is also shown as a mouseover hint in the view menu: 

Time slider: Ctrl+Alt+T 

Playback controls: Ctrl+Alt+C 

Device  tree:  Ctrl+Alt+D 

Alarm list: Ctrl+Alt+A 

Tabs: Ctrl+Alt+V 
 

 

Small controls to the right of Playback panel and Time Slider to control the button configuration and Time slider configuration: 

 
 

Playback panel 

Control of the view mode 

Choosing of the control configuration: date, time, activity, frame step controls, speed slider, quick bookmark button, cameratour 

controls and tab change controls 



 
 
 

Time slider: 

Control of the view mode 

Zoom level 

Bookmark display control (moved here from EasyView settings) 

Alarm display control and filter which alarms are shown in time slider. 
 

 
 

Dynamic camera administration in System Manager - improved control of the camera settings without the need to edit camera-driver 

specific configuration files. (Currently available only for select camera manufacturers.) 



 
 

AVM Operator Console plugin can now be paced into a camera grid cell. 

TruStream - dynamic stream selection - now also allows a multi-stream connection to form even if the image aspect ratio changes with 

the other stream. NOTE: This can lead to some flickering in non-fixed image grids. If this is seen as disturbing, the stream setting for 

this camera can be set to be something else than automatic. 

Clients support now logging-in to multiple different 32- and 64-bit servers 

Users do not have to uninstall VMS or use two PCs to simultaneously use 32- bit and 64-bit servers any longer 

EasyView Multi-master Support - EasyView can connect to multiple Master Servers (SMServer instances) simultaneously 

Using of this feature requires: 

EasyView and primary Master Server must be V8.1, or later 

Client reinstall (uninstall previous VMS or EasyView and install with the new installer again) 

Master Server license must be be updated with the multi-master feature 

The user can connect to a single Master Server without updating the license. But trying to start an additional EasyView 

to run concurrently to the first one, requires the additional Master Servers to have the license value activated. 

 
One a EasyView window is connected to one Master, additional EasyView windows can be connected to additional 

Masters Layouts and settings will be managed per server, so activating layouts for one server only updates the EasyView 

windows that were logged in to that server. 

Pressing the "Delete" key during EasyView start displays the Master Server selection screen 

 



 

The EasyView VMS application launcher and updater (VAU) can also be used with command line parameters: 

"-c EasyView.xml -a 192.168.100.22 -p 5108" will start EasyView forcing it to logon to server 192.168.100.22:5108 

 

EasyView can have a dark or light color scheme (only in EasyView VMS V8 Entegra) 

 



 

Alarm colors can be customized in System Manager for each alarm separately 

 
 
 

 
 

 



I/O or Audio can exist in a grid cell (taking over the whole cell) 

 

 
The Activity panel (time slider) can have two display modes: 

Normal (compact) mode: Activity, bookmarks and alarms are all on top of each other in single bar (new) 

 
Full (expanded) mode: Activity, bookmarks and alarms are separated into three different bars (like before) 

 
The user can toggle the visibility states with CTRL + ALT + T (off / large / normal) 

 
The EasyView numeric keypad popup dialog can be moved to a position on the screen that user prefers (with mouse drag and drop): 

 
System Manager now hides the camera passwords until the "Show password" checkbox is selected: 



 

The PTZ/dome control has been changed to cover less of the video material when the PTZ control is active: 

 
 
 
 
 
 
 
 
 
 
 
 
 

Advanced use: The PTZ control size can be controlled from the EasyView.exe.config XML file (located in 

c:\users\[user]\appdata\roaming\dvms\EasyView\[EasyView version = 8.1.1 64bit]\ folder – value DomeIconSize). Making the 

value zero, will make the control invisible. 

Note that always after changing the value in the EasyView.exe.config XML file, EasyView must be restarted. 

 
Failover recovery is now easier than before: The recommended recovery mechanism is still to restore the system with a known backup 

file, but now the restore dialog has the option to force automatic backup to be run right after a successful restore. This generates a fresh 

system backup so as to make it possible for the failover to work during the same day after the restore, without the need for manually 

performing a forced automatic backup, or copying a backup file to the automatic backup directory. 
 

New TruStream dynamic stream selection feature: When the camera is configured with multiple streams, it is now a default option for 

EasyView to use any appropriate resolution stream when the camera is displayed smaller than full size in the camera grid. 



 
 

As soon as the camera is expanded to large view, or the camera quickzoom is used, the image automatically switches to a higher resolution 

stream. This feature will save lot of bandwidth from server to client and will make image drawing smoother. 

 
 

Version 8 Introduction 

 
The schedule and release content for future releases remains subject to change without notice! 

The main design drivers for EasyView VMS Version 8 are: 

Unsurpassed usability 

Significantly reduced cost of installation, configuration and operation with several features designed to ease server management 

World-class integration; connects to any system 

Use-anywhere access with browser based HTML usage (both for video surveillance and for administration) 

Unlimited high performance storage (EasyView TruStore) 

Unlimited system size (amount of servers and cameras) 

Unlimited flexibility in assigning cameras to server resources 

Single system license, removing the need to maintain individual server licenses ( 

Backwards compatible with earlier EasyView VMS servers (V6 and V7) 

The full features of version 8 will be realized in three major delivery steps during 2017 and 2018: 

Version 8.0: Available March 2017 

Version 8.1: Available June 2017 

Version 8.4: Targeted release 4th quarter, 2017 

Version 8.5: Targeted release 1st quarter, 2018 

Version 8.9: Targeted release 2nd half, 2018 

Version 8.0 contains: 

EasyView TruStore: Unlimited storage drive size with excellent robustness and performance 

New, modern EasyView EasyView look and feel with efficient operation and world class 

usability Smart Event Management connectivity solution 

Version 8.4 will introduce: 

HTML clients for users and administrators 

Single system license 

Features designed to significantly ease the system install and administration. 

System capacity increase for maximum 200 servers 



New Features In V8.0.0 
 

EasyView TruStore 
 

EasyView TruStore is designed to meet the challenging requirements of the modern, high-resolution camera streams. The new storage solution 

allows to use any size hard disks for storage, and there is no limit on the amount of storage a single server can handle. The system is also more 

tolerant to connectivity issues to the hard disks. A momentary write failure will not impact the system in the long term. 

In the future, more features will be developed for EasyView TruStore, for example the ability to block material from being deleted or the control of 

certain devices writing to certain drives. 

EasyView TruStore is not compatible with the earlier storage format, so if an existing server is upgraded, the material will be lost. It is therefore 

strongly recommended to archive material before a server upgrade. 

 

Compatible With V6 and V7 EasyView Servers 
 

Users can start using V8 very easily, because the V8 Master Server can support both V6 and V7 networked VMS servers. In an existing V6 or V7 

system, only the Master Server and client applications need to be upgraded to V8 in order to start utilizing new features. 

 

V8 License 
 

Version 8.0 and 8.1 do not yet use a single system license. The Master Server and V8 VMS servers still require individual licenses in V8.0 and 

V8.1. 

 

New Application Icons 

 

 
New Camera Support 

 
H. 5/HEVC video enoding format support. 

H.265 reduces camera bandwidth and storage space requirements between 40% to 60% depending on the case. 

Mobotix MxPEG encoding format support support 

Support for any model 360 degree cameras with OpenCV based image de-warping 

 

New Look and Feel for EasyView 
 

The EasyView client User Interface has been modernized and redesigned to offer greater usability and effectiveness; 50% more space is now 

given to the camera viewing area. 

 
 

Title Bar Menu 
 

Several features have been relocated to a new title bar menu: 

 
 

The File menu can be used to open new windows and tabs, access media and open settings, as well as log off and exit: 



 
The Alarms menu offers access to Alarm view and Alarm popup tabs: 

 

The Search menu has all the search plugins (Alarm search, Motion search, Text data search & Thumbnail search) 

 
The Devices menu has camera, IO and layout number control and joystick settings: 

 
 

The Profiles menu can be used to switch between profiles: 

 
 

The Layouts menu offers access to layouts, saving a new layout and the layout management (editing) view: 

 
 
 
 
 
 
 
The View menu allows to change the window zoom level, edit camera grids, and control the individual view components visibility: 

 
EasyView plugins can be opened from the Plugins menu: 



 
.The right top corner now has a system status message icon: 

 
The Help menu is unchanged in V8. 

 
 

Device Tree 

In addition to the devices, the device tree now has also a tree of: 

Layouts, 

Plugins, 

Bookmarks, and 

Saved tabs 

The text filter field will work on all of the device tree content: 

 

 



Layouts and bookmarks can be managed directly from the tree. Opening a layout or a bookmark works with a double-click: 
 

EasyView plugins can be opened with a double-click (opens a new plugin tab) or by drag and drop (opens the plugin to the target camera grid cell): 
 

Saved tabs can also be opened with a double-click. 

 
 

Activity and Playback 
 

The activity panel and playback panels are now separated, so that they can be individually either shown or hidden: 
 

The Playback panel has three different size options. 

Normal (default): 

 



Large (contains activity selector, speed slider and camera tour controls): 
 

 
 

Minimized: 
 

. 

In contrast to before, also tab control visibility can be defined. 
 

The Auto-hide can be used to take the window automatically to full-screen mode. The full-screen mode will automatically drop back to normal 

when mouse or keyboard is used. When auto-hide is not used, the window will go to full-screen mode by pressing of the F11 key. The fulls-creen 

mode can be exited with Escape key. 
 

 
 

Exporting 
 

The camera export is achieved now by dragging the camera on top of the time slider. 
 

The export control box is now only displayed if there is content to be exported. 



 

 

Window Placement 
 

In general , the EasyView window can be now made much smaller than before, the minimum window size is 640 x 480: 

 
 

 
 

 

This is especially useful if the window auto-hide feature is used. The camera window can now be arranged to appear full-screen when in a small 

individual window. Such individual windows can also be tiled on the screen, giving 4 different EasyView windows appearing as a camera grid. 

This makes it possible to have multiple playback times on the same monitor. 

The EasyView image can also be stretched to multiple monitors by stretching the window size. 

 
 

 

Alarm Visualisation 
 

Alarms can now be visualized in the activity panel: 



 
 

They can be accessed by right clicking the alarm bar: 
 

The visibility and the highlight colors can be controlled from EasyView Settings: 
 

 
 

Bookmarking 
 

The Quick bookmark button makes a bookmark of the currently played time and content. 
 



Activity Data Cache 
 

It is now possible to cache the camera and alarm activity data to the client for faster access. It is also possible to do continuous background 

activity data updates, not only when camera is viewed. Such background updates will mean that activity graph is drawn much faster than before. 

This setting is controlled from EasyView settings. 
 

 
 

Alarm Comments 
 

Alarms can be commented in the Alarm search plugin: 
 

 

Alarm Filtering 
 

The Alarm popup tab can be filtered to show only specific alarms. This enables users to configure multiple alarm monitors which show only certain 

alarms. 
 



 
 

 

Image Scaling 

Finally, it is possible to set EasyView to use two different image scaling algorithms: Best 

performance (default) 

Best appearance (choose "Enable smooth video scaling" option in Advanced setting 
 

 
 
 

 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 



New Look and Feel to System Manager 
 

System manager gets similar look and feel as EasyView: 

 
 

 

Notes on Upgrading 

If you are using VCA (Video Content Analytics) on a V5 or a V6 server, the VCA license must be updated. It is recommended to take the 

VCA Configurator HWGUID from the earlier version, and contact EasyView sales for a new VCA license prior to installation of V8. 

Recommended method of upgrading a server to V8: 

1. Still, with the old software version; create a system settings backup in System Manager. 

2. Have the new V8 license ready. 

3. Recommended to use "Full" installer 

4. Start the V8 installer and install the new VMS version on top of the previous installation. (alternatively you can uninstall the 

previous version VMS and then start the V8 installer) 

5. When the installer asks for a license, give the V8 license. 

It is also possible to upgrade via the System Manager - "Upgrade recorders" tool. In this case, first upgrade each server's license to a V8 

license, and then use the "Upgrade recorders" tool. Please note that upgrading from V7.5.x or earlier version will format the storage 

drives, causing the stored material to be emptied. 

It is possible that layouts generated with previous versions of EasyView do not work 100% with latest V8 EasyView because of some 

changes done to the user interface. Some re-adjustment of the layouts might be needed. 

For details, see the EasyView VMS Installation Guide. 
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